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Introduction and Safety

1.0 Support

1.1 Safety & Warnings

For Muse Servo support, please go to... 
https://signwarehouse.com/blogs/content/muse-servo-support-resources

Please read the following safety guidelines regarding use of your Muse Servo cutter:

Symbols inside triangles represent important notes that warrant your full atten-
tion. There are different symbols denoting specific warnings. The symbol at left, for 
example, warns of a possible danger of electric shock.

The cross-bar indicates activities that are prohibited because of risk of injury or 
possible damage to your equipment. This particular symbol at left warns against 
the use of tools to remove parts of the equipment.

Don't use with an electrical power source which doesn't meet the required 
voltage rating.  Using with substandard sources of electricity may result in fire or 

Don't use your Muse Servo if it begins to emit an odor or smoke.

Don't un-plug your Muse Servo while powered on. Doing so may damage the equipment.

Make sure your Muse Servo  is grounded. Using your Muse Servo without it being 
grounded may result in risk of equipment damage or electric shock.
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Thank you for choosing a Muse Servo vinyl cutter.



Don't disassemble your Muse Servo or attempt repairs unless 
directed by SignWarehouse technical support.

Don't drop any liquids or metal objects into your Muse Servo. Liquids or 
impact from hard or heavy objects may damage the equipment.

Touching your Muse Servo’s blade with your finger may result in injury.

Don't damage or replace the power cable supplied with the vinyl 
cutter. Don't excessively bend, pull, or fold the power cable or place 
weight on it.  Crimping the power cable may result in risk of failure 
or electric shock.

If you're not going to use your Muse Servo for a long time, unplug the power 
cable from the outlet.

Placing your hands on the cutting platen during operation may result in injury.

Place your cutter on a stable surface. Operating the vinyl cutter 
on an  unstable surface may result in a fall that can damage the 
equipment or internal components.

To unplug the power cable from a receptacle, always grasp 
the plug instead of the cable. Pulling the cable may 
damage it and increase the risk of fire or electric shock.

Don't operate during an electrical storm where lightning is present. For 
protection against power surges, a surge protector is recommended.

Don't physically move the cutting head while your Muse is powered on. 
Manually moving the cutting head during operation may damage the main 



1.3 Warranty

1.4 Muse Servo Contents & Accessories

The Muse cutter comes with a one-year parts warranty. If you have any questions about your 
cutter’s  warranty, please contact SIGNWarehouse at https://signwarehouse.com/pages/con-
tact-us.

It is recommended that you keep your original box with the Styrofoam packing materials in case 
your  Muse Servo must be shipped or returned to SIGNWarehouse. 

Besides the cutter, your box should also contain the following items:

Accessories Box containing all of the 
following except for the Cutting Mat

Power Adaptor

Servo24 Servo60

Power Cable

USB Cable (white or blue)

30° Blade

45° Blade

60° Blade

Blade Holder

Test Pen

Cutting Mat
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1.5 Parts of the Muse Servo Cutter

 Parts of the Muse Servo24 and Servo601.5.1

Fig. 1.5.3

Fig. 1.5.4

Fig. 1.5.2

Fig. 1.5.1



1.6 Accessories

1.7 Pinch Rollers

The test pen is used in calibrating the Muse’s camera (Section 
3.01), calibrating the Scale (Section 2.07), and is also 
recommended for test drawing while you are learning where 
shapes will cut based on various software settings. Note that a 
small piece of wax needs to be removed from the pen’s nib before 
use. You may also wish to cut off the very top of the pen refill so 
that it more easily fits into your Muse:

Your Muse is designed for cutting rolls and sheets of adhesive-backed films such as vinyl, 
stencil mask and sandblast etching films. It can also use the included cutting mat for 
non-backed materials such as paper, cardstock, magnet sheets and Mylar.

The MUSE Servo 24 and 60 have individually actuated pinch roller levers. This enables more 
precise control of pressure applied to  roll media. NOTE: Always activate pinch roller 
symmetrically, with the same number of rollers lowere on the left and right sides of loaded 
vinyl. Asymmetrical application of pinch rollers may cause media to skew as it’s fed trough the 
cutter. 

Insert the media into the space between the pinch roller and grit roller and pull out the media 
far enough to ensure that it is loaded straight. The edges of the vinyl should be parallel to the 
left and the right frame of the cutting platen. (A ‘platen’ is the lower plate that supports the 
vinyl as it passes through the cutter.)

The 30° yellow capped blade (not shown) is well-suited for window 
tint and fabric. It is included with the M60.

The 45° red capped blade is well-suited for cutting thinner materials such as heat 
transfer vinyl and wall/auto/decal vinyl. Two of these are included with the Muse.

The 60° blue capped blade has a longer cutting edge and is well-suited for cutting thicker 
materials like sandblast stencil, flock, craft foam, magnet sheets, light chipboard, 
rhinestone template materials, etc. It is included with the M15 and the M24.

Installing the blades into the blade holder is covered in Section 2.01. Blade Offset is 
covered in Section 2.02.2.

1.

2.

3.

 Test Pen1.6.1

 Muse Blades1.6.2

There are two kinds of blades that came with your Muse (note that which two 
kinds differ depending on the model you purchased).



1.8 Control Panel

When you first power on the Muse, the following Main Screen 
or Home Screen will be displayed after several seconds:

The functions of the buttons on this Main Screen are:

SETTINGS: Opens the SETTING menu with access to other 
functions, such as CAMERA, WI-FI, ARRAY, ADVANCED SETTINGS, 
etc.  See Section 1.8.1.

RECUT: Recuts the last job which is stored in the Muse’s memory. 
Note that while the Muse is cutting, this button will read PAUSE. 
Pressing it will pause the cutting process in case any changes 
need to be made. Pressing again will resume the cut.

USB: Opens the UDISK window allowing access to files on a USB 
thumb drive plugged into the Muse’s USB Flash Drive port. Files 
must be saved in .PLT format to appear in the menu 
(See Sections 1.10.6 – 1.10.8 for details).

STOP: One-touch emergency stop button stops the cutter and cancels the cut.

SPEED/FORCE: This button opens the SPEED/FORCE screen where you can optionally set the 
cutting speeds and force of the cutter, as well as access the stored presets (See Sections 
2.2-2.5).

TEST: Press the TEST button to cut a small square. This is recommended to ensure a clean cut is 
achieved with the current settings before proceeding with a cut job.

Slide the pinch roller assemblies left and right so that the pinch rollers are centered over 
the grit roller. The positions of the exposed grit rollers in the platen are marked by white 
squares above the platen. The white pinch roller alignment flags are clearly visible from 
the front of the cutter.

Once the pinch rollers are in position, lower them to keep 
your media in place. When using the cutting mat, you 
need at least two wheels near the outside edges of the 
mat, thus center the mat inside the cutter (versus having it 
all the way to one side).

Actuation of the princh rollers is simple and intuitiive.
From the back of the cutter, raise the lever to raise the pinch
roller from the platen. Lowering the lever lowers and actuates
the pinch roller. 

Fig. 1.8.1

Fig. 1.7 Raised Pinch Roller



Arrows: The left-right arrows move the tool carriage while the up-down arrows move the 
grit rollers. This allows you to start cutting anywhere on the media (i.e. set an origin).

Double Arrow: The double arrow button controls the speed of the tool carriage and grit 
rollers while setting a new origin. The default setting is the faster mode. Pressing this 
button once will change the color of the button from blue to red, which indicates the 
slower mode. This mode can be used for very precise movement.

 Settings Menus1.8.1

The Setting menus provides access to seven additional screens 
on two different pages: There are three Settings Menus:
Settings, General Settings, and Advanced Settings. 
The functions found on the Settings Menu Are...

TO START: return the blade holder to the origin (the location immediately before the cut was 
started

TO END: advance the blade holder to the top of the completed cut with the option to move an 
additional distance

To LEFT: advance the blade holder to the left of the completed cut with the option to move an 
additional distance

ADVANCE SETTINGS: Refer to Section 1.8.3.

GENERAL SETTINGS: Refer to Section 1.8.2.

SYSTEM INFORMATION: Hardware and firmware versions, Baud rate, and other settings that 
should need no adjustment unless directed by a SignWarehouse technical representative.

 General Settings1.8.2

On the Settings Menu, Press the General Settings button
 at bottom left to access the General Settings Menu. 
Here, you will find functions for
LED
Screen and Alarm
Unit
Language

CAMERA: Opens the CAMERA SETTINGS menu. 
Refer to Section 3.00.

WIFI: Connect the MUSE to your home or office router for 
wireless connectivity (refer to Sections 1.10.4 and 1.10.5).

ADVANCE MODE: Three options for where the blade holder goes at 
the end of a cut: Fig. 1.8.1

Fig. 1.8.2



LED: This option allows you to customize the platen lighting in your Muse.
The LED lighting’s primary benefit is in providing ideal illumination during scanning of printed 
registration marks when contour-cutting printed media. This diminishes the possibilty that 
poor ambient lighting will
interfere with scanning and contour-cutting. 
The default setting is ON with the LED at 255, which is  100% white in RGB color. You can adjust 
the brightness of the lighting by touching and swiping the wide button at the top of the display, 
or simply turn it off by pressing the Off button.
    

 Advanced Settings1.8.3

Press SETTINGS on the Main Screen, then select ADVANCE 
SETTINGS. The functions in the Advanced Settings Menu  are:

SHOW POINT: This feature shows the origin point 
of your cut jobs. When toggled on, the Main Screen 
will display an updated center button used to reset 
the origin, as well as some location positions (See Fig 1.8.4).

Absolute Location displays the current location relative to the 
“power-on” origin point of (0,0):

X is the position relative to the movement 
of the cutter’s tool carriage from left to 
right across the platen.

Y is the position relative to the forward and 
backward motion of the media as it is fed 
by the grit rollers.

L is the straight-line distance from X to Y.

ALARM: Enabling ALARM AFTER COMPLETED will produce an audible alarm of 5 beeps once a job 
completes. Uncheck this box if you wish to turn off this feature. Similarly, enabling LED AFTER JOB 
COMPLETED will change the LED color to blue once a job completes. 
This feature is only on the M15 and M24 models.

SCREENSAVER: After a predetermined period of time, the cutter goes into standby mode to save energy 
and the LCD screen will darken as the cutter goes to sleep. You can change the amount of time before 
sleep mode begins.

UNIT: This setting allows you to choose the unit of measurement for all functions involving distance, 
such as the spacing between repeats or position of the cutting head. The default setting is 
MILLIMETERS (mm). The other option is INCHES (in). Because the SPEED and FORCE settings on a Muse 
are based on a scale versus units, they remain the same whether you are in imperial mode or metric.

LANGUAGE: This screen offers a choice of three languages: English, Spanish, and Mandarin. You can 
choose one of these for the language in which all settings and menu communication are displayed

Fig. 1.8.3



Relative location displays a new location relative to the last origin you 
set. This will match the Absolute Location until you press the origin 
set button:

 Array Setup1.8.4

This feature allows you to convert one cut job into multiple copies 
and arrange them in rows and columns.

Tap the ARRAY button to open the ARRAY SETTINGS screen:

Use the Array function to pre-plan a pattern of copies to be cut 
from
one file. Sending a single copy fo a vinyl graphic from your PC with
the Array function activated allows the MUSE SERVO to 
automatically
process multiple copies of the job in a pattern of your choosing.
There are two data fields labeled X, Y on the screen. Use these to 
determine the number of copies, arranged in rows and columns, 
and the amount of space (margins) betwen rows and columns. 
• The X value at the top determines the number of columns.
• The Y value at the top determines the number of rows. 
• The X value at the bottom determines the space between 

columns.
• The Y value at the bottom dertermines the space between 

rows.

Y KEY MODE: This setting controls how the Muse cutter moves your 
media forward or backward (along the Y axis), as you press the 
up/down arrow keys on the control panel.

SCALE: This setting is used to input the sizing calibration. Refer to 
Section 2.7.

x is the current left-to-right distance moved from the last origin 
(how far you have moved the tool carriage across the platen).

y is the current up-&-down distance moved from the last origin 
(how far you have moved the media forward or backward in the 
Muse).

In the DEFAULT setting, pressing the up arrow moves the media 
forward and pressing the down arrow moves it backwards.

Setting the Y KEY MODE to INVERSE will flip this so that pressing 
the up arrow will move the media backwards.

Fig. 1.8.4

Fig. 1.8.5



Depending on which software you purchased with your Muse vinyl cutter, 
there are two ways to set it up:

1.

2.

Place your Muse Servo on a sturdy horizontal surface. Keep the area around the cutter free of clutter 
and unnecessary items. This will prevent other objects from obstructing normal feeding of media 
through the cutter. Impacts with items around the cutter can cause a material to lift off the platen or 
feed incorrectly. Either of these can negatively impact cut quality and/or tracking.

To turn on the power, press the top of the power switch (toward I ) at the bottom of the left end cap, 
directly in front of the power cable socket.

The Muse will take a few seconds to power up. The LED light will come on and the tool carriage will 
engage. NOTE!: Once the cutter is on, do not move the tool carriage manually. This can damage 
the tool carriage and/or main board. Use only the arrows on the control panel to move the tool 
carriage.

To power off your cutter, press press the bottom of the power switch (toward 0). 

There are 3 ways that you can connect your Muse Servo to the computer:

You may choose any one of these three connectivity options. You can also change from one to the 
other at will, but for best results use one at a time. Here are the benefits of each connectivity option:

You’ll find complete step-by-step instructions on our Product Support 
Blog for LXi. Please click here to access the setup tutorial or go to 
https://signwarehouse.com/blogs/support/lxi-22-support-resources

To install Create Space, download the software from the following 
link (note there are separate links for Mac and Windows users). You 
will also find a video to assist you with installation and activation of 
your registration number: 
https://techsupport.signwarehouse.com/create-space-soft-
ware-support-resources/

1.

2.

3.

1.

USB Cable

Wi-Fi

USB Flash Drive

The USB cable is the simplest and most reliable connection. Setup is quick and easy. See 
Sections 1.10.1 or 1.10.2 for instructions.

1.9 Registering and Installing the Design Software

1.10 Connecting a Muse Servo to Your Computer



 USB Connection in LXi1.10.1

Turn on the Muse before connecting to your computer. Using the USB cable that came with the cutter, 
plug the wider end into your computer’s USB port and the squarish end into the cutter’s USB port 
which is on the right end cap (see FIG. 1.5.4).

Open LXi Production Manager. If this is your first time opening LXi, a popup screen will request a 
Brand and Model selection. Otherwise, select Setup and from the drop-down menu, click Add Setup.

From the pop-up window, choose MUSE as the Brand. Find and select M15, M24 or M60 in the Model 
window:

Click Next. The setup window will ask how your Muse Servo is connected to the computer. Open 
the drop-down menu and select the largest available option for USB_Printer_X where X will be 0, 
1, 2, etc. For example, if you see both USB_Printer_0 and USB_Printer_1 then you would select 
USB_Printer_1 because it is the higher of the two. It is not recommended that you select USB001 
or USB002 (or other) from that menu. They may work for basic functions but may not adequately 
support contour cutting.

Click on Finish at the bottom of the Add Setup window.

2.

3.

Wi-Fi takes a little more time and care to set up but offers a wireless environment in 
which the cutter can be used without being connected to the computer on which the 
software is installed. See Section 1.10.3 and Section 1.10.4 or 1.10.5 for detailed 
instructions.

The USB flash drive option allows you to use the cutter without being connected to the 
PC. Files can be saved from the design station computer in .PLT format and transferred to 
the cutter using a USB thumb drive. See Sections 1.10.6 - 1.10.8.

Fig. 1.10.1

Fig. 1.10.2



Turn on the Muse Servo before connecting to your computer. Using the USB cable that came 
with the cutter, plug the wider end into your computer’s USB port, and the squarish end into 
the cutter’s USB port which is on the right end cap (see FIG. 1.5.4).

Open Create Space and select New Project.

Go to Cutter>My Cutter>Manage Cutters and a new window will open (FIG. 1.10.3).

A new window will open. On the right side, under Company/Brand select MUSE and under 
Model select M. Click Add to list. Click Done to apply and close the window.

Once you are ready to cut, click the Cutter icon on the Toolbar at the top of the screen. The 
Cut Settings window will open and, in the Connection drop-down menu, select USB. You can 
change the port or leave it on Auto Detect. If you click on Test Connection, it should move the 
blade carriage back and forth one time. This does not send a cut, just a signal to the cutter.

 USB Connection in Create Space1.10.2

For initial setup using the Wi-Fi option, you may need to place the Muse Servo in the same 
room or in close proximity to the Wi-Fi router. This will create a stronger connection and 
faster Wi-fi network configuration. Once the connection is set, you can move the cutter 
around within the limits of your router’s coverage area.

 Connecting the Muse Servo to a Wi-Fi Network1.10.3

Fig. 1.10.3

Fig. 1.10.4



You will need the name of the network and the password.

Carefully complete the following steps:

1.

2.

On the Control Panel, press the SETTINGS button to access the 
SETTINGS menu:

Press the WIFI icon (Fig 1.10.3).

3.

4.

5.

In the next screen, press the SCAN button and a list of wireless 
networks will appear. Select your network and press APPLY.

Press the SET button and enter your network password. Press 
OK.

An IP address (IP ADDR) will appear. The first three sets of 
values will be obtained from your network. Use the + or – 
buttons to set the last digits of the IP ADDR that you wish to use:

Fig. 1.10.3

Fig. 1.10.4

Enter Network Password

Enter IP Address

Choose Available Network

6. Press APPLY to set the changes and add the Muse to your 
wireless network. This can take up to a minute or longer.

If the APPLY button on the Muse Servo WiFi screen changes to 
CONNECTED OK, you have successfully connected!

If the APPLY button changes to PASSWORD ERR, check your 
settings, and enter the correct values.



A menu of available networks will appear. Select the network used for the Muse setup 
and, if needed, enter the network password. Wait a bit for the connection to be made and 
the menu should indicate you are now connected to that network.

Proceed to either the next section (if using LXi Production Manager) or Section 1.10.5 (if 
using Create Space).

7.

8.

9.

10.

11.

Note the complete IP address at the top of the window (FIG. 1.10.4). You will be entering this 
same IP address in the software you use for cutting.

If you need to reset or change networks, press and hold the DEFAULT button for 3 seconds. 
This will reset the settings and enable you to change the network.

Before connecting the Muse to your computer using a Wi-Fi connection, you must verify 
that your computer is also connected to the same network. To do this, locate and launch 
the network icon for your computer:

On a PC: On a Mac:

Click on the Network icon.
(usually in lower right corner)

Click on the Network icon.
(usually in upper right corner)

If you are connected via
Ethernet, your network icon

may look like this.

 Wi-Fi Connection in LXi1.10.4

Open LXi Production Manager. If this is your 
first time opening LXi, a pop-up screen will 
request a Brand and Model selection. 
Otherwise, select Setup and from the 
drop-down menu, click Add Setup.

From the pop-up window, choose MUSE as 
the Brand. Find and select SERVO-24 or 
SERVO-60 in the Model window:

Fig. 1.10.5



Click Next. The setup window shown in FIG. 1.10.9 will ask how your Muse is connected to the 
computer. Select TCP/IP. A small window will appear in which you can type in the cutter’s IP 
Address from Step 7 in Section 1.10.3 (FIG. 1.10.7)

Below TCP/ IP address, you will need to 
enter the correct Port number which is 
8080. Enter this value and click Test. If you 
have a successful connection, LXi will 
indicate success. Click on OK to close the 
Communication window. Click on Finish at 
the bottom of the Add Setup window.

If Test fails, check the Muse Servo again to 
verify the network name and the IP 
address. If you change settings, it may be 
necessary to wait a minute and start from 
the beginning of the process in order to 
allow the computer time to reset and 
recognize the Wi-Fi connection.

 Wi-Fi Connection in Create Space1.10.5

Open Create Space and select New Project.

Go to Cutter>My Cutter>Manage Cutters.

A new window will open. On the right side, under Company/Brand select MUSE and under 
Model select M. Click Add to list. Click Done to apply and close the window:

Once you are ready to cut, click the 
Cutter icon on the Toolbar at the top 
of the screen. The Cut Settings 
window will open and, in the 
Connection drop-down menu, select 
TCP/IP (FIG. 1.10.11)

In the IP field, type in the IP Address 
from Step 7 in Section 1.10.3.

Once you type in the IP address, 
click on Test Connection, it will 
move the blade carriage back and 
forth. This does not send a cut, just 
a signal to the cutter. If not 
connected, you may need to change 
the IP address to a free number on 
your system.

Fig. 1.10.11

Fig. 1.10.9

Fig. 1.10.10

Fig. 1.10.11



 USB Flash Drive Setup in LXi1.10.6

If you are new to LXi, follow the first few steps in Section 1.10.1 to add the Muse Servo to LXi 
Production Manager.

Using the UDISK (USB thumb drive) option involves saving a .PLT file containing the cut design and 
some or all of the cut settings. This file can then be opened directly onto the Muse Servo and cut. 
Remember that with this option, once the file is saved to the thumb drive, the design is locked in 
and cannot be edited, other than setting up an array of repeats.

Once your file is ready to cut in LXi, insert a USB flash drive into the design station computer.

Click on OK and LXi Production 
Manager will open.

The Cut/Plot window will also have opened. On the General tab, select SAVE to FILE from 
the Send mode drop-down menu:

When you have made any necessary changes to the file size, copies, rotation, etc., click the 
Send button at the bottom right of the Cut/Plot window.

A window will open prompting you to select the desired location to save the .PLT file. 
Browse to the installed flash drive and save the file after entering a new name. Go to 
Section 1.10.8.

Change the Port connection by right clicking on the Muse Servo in the Production 
Manager list, and selected Change Port (as shown in FIG. 1.10.14)

In the Change Port window, select FILE and then complete other options, as 
preferred:

Go to File>Cut/Plot or click the Cut/Plot 
icon . A window will open and you will 
need to select the location of the LXi 
Production Manager in relation to your 
design station computer:

NOTE: if you will continually be using the USB Flash Drive as your method of sending files to the Muse Servo:

Fig. 1.10.12

Fig. 1.10.13



If you are new to Create Space, follow the first few steps in Section 1.10.2 to add the 
Muse to Create Space.

Using the UDISK (USB thumb drive) option involves saving a .PLT file containing the cut 
design and some or all of the cut settings. This file can then be opened directly onto the 
Muse and cut. Remember that with this option, once the file is saved to the thumb drive, 
the design is locked in and cannot be edited, other than setting up an array of repeats.

In the Cut Settings window, verify you see the design in the Preview as shown in FIG. 1.10.15, 
and choose either Origin Point (move shapes to cut at the origin) or WYSIWYG mode (leave 
shapes in location on virtual mat in main window) depending on which you prefer.

Mark the box for Use Software Speed and Pressure, if you want those included in the file. 
Otherwise, leave the box unchecked and you can set those values on the Muse Servo’s 
control panel. The other cut settings including Blade Offset, Overcut, and Multi-cut 
(Passes) will always be included in the .PLT file:

Once your file is ready to cut, insert a USB flash drive into the computer. Click on Save to File 
at the bottom of the Cut Settings window. A new window opens where you can browse to find 
the USB flash drive, name the file, and mark the box for Add registration marks, if this is a 
contour cutting application.

 USB Flash Drive Setup in Create Space1.10.7

Fig. 1.10.14

Fig. 1.10.15



 Loading and Cutting a .PLT File from the USB Drive1.10.8

Insert the USB flash drive into your Muse Servo cutter’s USB Flash Drive Port (see FIG. 1.5.4).

On the Main Screen, press the SPD/FOR button and change the FORCE and SPEED settings if 
you did not elect to send them within the .PLT file (refer to Section 2.02.1). Perform a test 
cut, if needed.

Press the USB  icon on the Home Screen. Press OPEN to access the files on the USB flash 
drive. The Muse Servo will browse the contents of the installed USB thumb drive and display 
all readable .PLT files (Note: If there are folders on the drive, you may have to use the touch 
screen to open the correct folder to find the saved .PLT file).

Locate the file you wish to cut and touch to select it. Then touch the START CUT button to 
send the job.

Press START CUT to cut the .PLT file. Note that if you want to cut repeats refer to the Array 
function covered in Section 10.8.4.

1.11 Maintenance

All Muse Servo cutters are made with high-quality internal lubrication to protect all mechanical 
components. Therefore, there is no need to oil or lubricate any of the components, ever! Daily 
care consists of cleaning the platen and blade holder to prevent buildup of dust and material 
debris. Dusting the platen with a soft brush will get the job done perfectly. Debris inside the 
blade holder can be removed using a can of compressed air and a nozzle. Also, make sure the 
pinch rollers and grit rollers are kept clean and free of any stickiness.

Fig. 1.10.16

Press the USB icon to navigate to 
the screen to view .plt files on an 
inserted USB thumb drive.

Touch the folders to open them. 
Touch to select the desired PLT 
file.

Once the desired .PLT files is 
selected, press the Start Cut 
button to send the job to the 



Cutting

2.0 Cutting Overview

To be a successful owner of a vinyl cutter, you need to keep in mind a few factors:

2

You’re going to make mistakes. This is normal and part of the process of mastering a 
cutter.

Read this chapter. It contains valuable information to help you understand how to load 
the blade, set the exposure, understand the effects of various cut settings, create presets, 
and set a new origin.

2.1 Proper Blade Installation

Before using the Muse Servo advanced control panel to set the cutting speed and force, it is 
important to make sure the blade is installed properly in the blade holder. Remove the 
protective cap on the blade and follow these instructions:

The blade tip only needs to protrude far enough to cut through the face film and adhesive of 
adhesive-backed vinyl. This is a combined thickness of approximately 0.005" or less. The blade 
should not extend farther than ~ half the thickness of a credit card.

When properly installed, the tip of the blade is barely visible (See FIG. 2.01.2 below). Adjust the 
blade inside the holder by turning the knob clockwise to extend more of the blade and 
counterclockwise to retract it.

Fig. 2.1.1



Now that you have inserted the blade properly in the blade-holder, you can use the Muse 
Servo’s control panel and menu options to expertly manage the speed and force of t             
he cutter. Cutting vinyl successfully requires managing the amount of force you apply to the 
material and the speed at which the tool carriage moves across the platen.

2.2 Cut Settings

Box Test: To make sure the blade is inserted properly, use the images in FIG. 2.1.1 as a guide. 
Once the blade is installed in the blade-holder, place a sheet of vinyl on a flat surface, and place 
the blade-holder against the vinyl. Try to hold it perfectly perpendicular to the surface (FIG. 
2.1.3). Next, move the blade-holder across the vinyl and draw a square. Set aside the 
blade-holder and try to weed the box.

Perfect. The blade cuts 
through the vinyl, but 
not the release liner.

The blade is too far out. 
It’s cutting all the way 
through the release 

liner.

The blade isn’t out far 
enough to cut through 

the vinyl.

If you cannot remove the box from the rest of the 
vinyl, you may not have cut deeply enough. The 
blade may need to be adjusted so that the tip 
extends farther.

If the vinyl lifts easily, but the release liner below is 
deeply scored or cut all the way through, the blade 
is cutting too deeply. Adjust it so that less of the tip 
is showing.

If you can easily weed the box, but the release liner 
paper below is barely scored (or not scored at all), 
the blade is installed correctly in the blade-holder. 
You are now ready to install the blade-holder in the 
tool carriage and use the speed and force settings 

Fig. 2.1.3

Fig. 2.1.2



Force Guidelines: There are different levels of force required for various kinds of self-adhesive 
vinyl and heat transfer vinyl. Generally speaking, thicker or coarser materials such as reflective 
vinyl or glitter-flake HTV require more force than standard 3 mil sign vinyl.

The Muse makes managing these settings easier. It allows you to store, edit, and recall saved 
settings for different kinds of materials, so you can quickly change from one type of film to 
another.

The recommended or optimal force varies for different materials. The ideal force setting may 
even change for different colors. White vinyl sometimes requires more cutting force than other 
colors, due to the density of the pigment. It’s always a good idea to perform a test cut before 
proceeding. This can be done using the TEST button on the SPEED/FORCE screen.

Speed Guidelines: In commercial signs and graphics, the faster you get a job done, the better. 
Time is money and speed saves time. So, it’s tempting to run your cutter at top speed all the 
time, but this is not always the best approach.

Think of the cutter making vinyl graphics as if you were drawing, holding a fountain pen, or 
cutting with a hand-held X-Acto knife. If you were cutting or drawing a large square, you could 
go very quickly. If, however, you were cutting an intricate image, you might want to slow down 
and make sure you got all the curves and corners right.

The same holds true for vinyl cutters. You can cut large simple graphics at maximum speed. 
Cutting small, intricately detailed graphics requires more care and should be done at lower 
cutting speeds.

Just as you would do manually, if you’re cutting something thick or tough, you would slow down 
to make sure you’re cutting with enough force. Likewise, when using your Muse, cut thicker or 
tougher films on a lower speed setting to ensure good cut quality.

US and VS Speed Settings: To make your cutter even more efficient, there are two available 
speed settings in the Muse control panel:

US is the ‘up speed’, the speed of the tool carriage when the blade is lifted off of the media, 
moving from the origin to the start of the first shape to cut, or when 
moving from one shape to the next.

VS is the ‘down speed’ or the speed of the tool carriage when the 
blade is in the down position, cutting the shapes from the media.

For instance, you may need to use a lower VS to cut a detailed graphic,
but you can leave the US at a much higher setting. Overall, there will 
be a time savings compared to use a lower VS for the entire project.

 Force and Speed2.2.1

Changing Speed and Force: To change the speed and force settings on 
your Muse Servo:

From the Main Screen, press the SPD/FOR button and the following 
screen appears: Fig. 2.2.1



You can change settings by either sliding your finger across a bar or by pressing the + or – 
buttons to increase or decrease the parameter. The green slider will change to show the 
Speed or Force selected, relative to the minimum and maximum values possible.

Both the Up Speed and Cut Speed are displayed on a scale from 1 to 13:

Force is displayed on a scale from 1 to 160 where 160 represents the maximum of 800g (on the 
M15 and M24 models) and 2000g (on the M60 model).

Once you have set the desired speed and force, load some vinyl and press the TEST button. 
Weed the pattern to determine whether the applied force is sufficient to cut through the top 
layer and adhesive, but not so much that it cuts through or deeply scores the release liner.

The Muse Servo has the ability to store up to eight combinations of Speed and Force. Refer to 
Section 2.03.

The settings from 1 through 4 are the slow speeds and should be used when cutting 
dense difficult materials.

The settings from 5 through 8 are medium speeds and should be used for easy-to-cut 
materials, such as cardstock, vinyl, iron-on transfer, and rhinestone template material.

The settings from 9 through 13 are the fast speeds and are useful for engraving and 
drawing. You may, however, find that some materials will cut well at the faster speeds. 
You can normally use this higher range for the Up Speed.

 Blade Offset2.2.2

Fig. 2.2.2

Fig. 2.2.3



Offset Adjustment: If you are cutting rectangular paths and find that paths which should have 
90° angles are instead rounded, the Blade Offset is too low. If the angles are sharp but 
distorted, the offset value is too high:

In either case, you will need to adjust the Blade Offset value in LXi Production Manager (see 
Section 2.5) or in Create Space (see FIG. 2.6.1). These are the base settings for each type of 
Muse blade:

30° yellow capped: 0.75 mm (0.03 in)

45° red capped: 0.3 mm (0.01 in)

60° blue capped: 0.4 mm (0.02 in)

 Overcut2.2.3

Correct Offset Too Low Too High

If your test cut has gaps in the paths or if the corners were not cut precisely, you may need to 
adjust the Overcut setting. This can be done on the Default Job Properties tab in the LXi 
Production Manager (see Section 2.5) or in the Cut Settings window in Create Space (FIG. 2.6.1).

Presets allow you to save your settings for a material. The 
Muse Servo can save up to 8 presets. The pre-loaded 
presets are for EnduraGloss, Holographic and Oracal 651 
vinyl, EnduraLITE reflective sheeting, and EasyWeed, 
Logical Color Warm Peel Universal, HotMark 70, and 
Logical Color GlitterSoft heat transfer film (HTV). 
Remember, these are just pre-loaded for your 
convenience and are intended to help you get started 
cutting our most popular self-adhesive films quickly and 
correctly. You can change these settings and/or replace 
them with your own presets.

Open an existing PRESET by pressing the LOAD button on 
the SPD/FOR screen (refer to FIG. 2.2.1). The eight presets 
are split between two screens:
Touching a present illuminates the preset number.  

Touch Load to apply that prese. The cutter retuns to the 
Speed/Force screen with the new speed and force settings 
applied

2.3 Presets

Fig. 2.3.1

Fig. 2.2.4



Rename Presets: When a preset has been selected, you can 
also rename it. Touch the preset to select it. Then Press the 
Rename button in the lower left corner.  The rename touch 
panel appears. Use the touch screen to enter the new name. 
You can toggle betwen upper and lower case using the Up 
Arrow key. 
Tap letters in quick succession to toggle through the options 
(eg one tap for A, two quick taps for B etc). Press OK to save 
the new preset name and return to the Speed Force menu.

 Saving a Cutting Parameters Preset2.3.1
The following steps show you how to create your own preset of cut settings:

1.

2.

3.

From the Main Screen, press the SPD/FOR button.

Enter the desired US, VS, and FS settings and press SAVE 
(refer to FIG. 2.2.1). The Preset screen will open.

4.

Press one of the custom preset boxes, as shown in 
FIG.2.3.2. The number will illuminate. Click   SAVE and 
that preset will be updated with the new settings. Press 
RENAME (as directed above) to update the name of the 
updated preset. Enter the name of the new preset you 
would like to save and press OK (Note: there is a 
15-character limit). 
Press Save to save the new settings and preset name.
This returns you to the Home screen with the new 
settings applied. You are ready to cut your design. 

2.4 Setting the Origin before Cutting

Setting an origin point is an important part of managing your material cost and using the Muse 
Servo contour cutting capabilities. Setting the origin point consists of using the arrow keys to 
move the tool carriage to a specific point on the cutter’s X axis (left-to-right on the platen) and 
advance the media forwards or backwards.

Once you have positioned the blade in a specific point over the media (typically close to the 
bottom right corner of the material), your origin is defined and you do not need to press 
anything before cutting.

Fig. 2.3.3

Fig. 2.3.2

Use the number/letter keys to spell the new name. 
Press the 123 key to toggle from letters to numbers. 

Press the Up arrow key for uppercase letters. 

Press OK when finished. 



To change the Blade Offset covered in Section 2.2.2, click on Properties and select the Cut 
tab . Enable the setting called Knife Offset and enter a new setting, using inches as the 
units.

NOTE: If you have activated the SHOW POINT option, you can press the middle button after 
setting a new origin point and the x and y values at that position will update to 0,0. As you 
move the tool carriage away from this origin point, the x and y values will show exactly how far 
away from this new origin point the tool carriage has moved. More details on the SHOW POINT 

2.5 Cutting from Vinyl Express LXi to the Muse Servo

When you are ready to cut, click the 
Cut/Plot icon to launch the Production 
Manager and open the following Cut/Plot 
window:

For a simple cut you only need to address 
the following on the General tab:

While there are quite a number of other cutting features you may need for your applications, take note of several 
common ones:

Calibrate the camera for contour cutting (refer to Section 3.1).

When you are ready to set an origin, press SET>CAMERA>SCAN>OK.

A photo will be taken. In that photo, press the corner of the reg mark or whatever other 
indicator you are using for an origin. This will move the red “+” to that position.

Again, press OK. For a contour cut, that should be close enough for the camera to find the 
first registration mark. However, if you need a very precise origin, such as for engraving a 
charm, continue the steps until the dashed lines are dead center with your indicator.

Make sure the correct cutter is 
selected at the top of the Cut/Plot 
window.

Verify the Material sizing is correct. 
If not, you can click on Properties, 
enter new dimensions and they will 

Make sure Send mode is set to Send now if you are cutting directly to the Muse Servo24 immediately.

Fig. 2.5.1

You can also use the Muse Servo’s camera to set a very precise origin for applications such as 
when engraving metal charms or for the placement of the blade holder over the first 
registration mark in contour cutting:

Check the Preview to 
make sure it seems 
correct.



2.6 Cutting from Create Space to the Muse Servo

When you are ready to cut, click on the Cutter 
icon to open the Cut Settings window:

Cut Mode controls where shapes will cut on 
the material. Typically, you will choose Origin 
Point to be more efficient with material. 
Shapes will be aligned and cut next to the 
origin you set on the material. If the Cut Mode 
is set to WYSIWYG, shapes will cut based on 
their placement in the document (mat) area as 
shown in FIG. 2.6.2 and 2.6.3.

Use Software Speed and Pressure: Enabling 
this option will use the Pressure and Speed 
settings in SCAL, thus overriding those set on 
the Muse Servo’s control panel.

When you are ready to send the project to the Muse Servo, click on Send.

To the right of the General tab is the Options tab , where you can set Passes if your 
material cuts better with more than pass.

Also to the right of the General tab is the Advanced tab , where you can modify the 
Overcut setting covered in Section 2.2.3.

Note that when designing in Create Space, you can use either Portrait mode (typically used with the included 
cutting mat) or Landscape mode (typically used for longer projects). These are set on the Document Panel to 
the right, along with setting up your document area under Mat Size. Keep in mind that the triangle (arrow) on 
the edge of the on screen can be used to indicate where your shapes will cut relative to the direction the 
material is fed into the Muse. You can also then verify, based on the preview in the Cut Settings window where 
the shapes will cut relative to the Muse Servo itself:
NOTE: When contour-cutting a printed graphic, you may need to rotate the image by 90° on the cutter’s platen 
in order for the MUSE Servo to read the registration marks correctly. 

As you can see in FIG. 2.6.1, there are other cutting functions available in this window, such as 
Cut Order, Cut by Color, Layers (Cut by Layer), Mirroring, and more.

When you are ready to send the project to the Muse Servo, click on Cut.

Fig. 2.6.2 Fig. 2.6.3Fig. 2.6.2

Fig. 2.6.1



2.7 Resolution/Scale Calibration

If you were to cut out any particular shape, for example, 
a 10” x 10” square, you might find that it actually 
measures 9-15/16” x 10-1/32”. It will be very close to 10” x 
10” but perhaps just slightly smaller or larger in either or 
both dimensions. Now this might be perfectly acceptable 
for the type of cutting you do. Therefore, it may not even 
be necessary to do this particular calibration. However, if 
you do want to make sure your shapes are cut precisely 
to scale, the following procedure will allow you to 
calibrate your Muse Servo cutter.

Using the test pen and a large sheet of paper, draw the square, noting which side was drawn 
left-to-right (which is the X side) and which side was drawing front to back (which is the Y 
side), as you face the Muse Servo head on.

To calculate the SCALE, divide the design dimension by the actual drawn dimension times the 
current SCALE. Thus, if you draw a 10” square and it measures ~10 1/32” (left-to-right) or if 
you draw a 250 mm square and it measures ~ 250.8 mm (left-to-right), then:

Repeat the test to verify the dimensions are correct. If you still need to adjust, repeat the 
calculation with the newly measured dimensions but remember to also multiply by the SCALE 
numbers you entered into the SCALE screen. Then enter those new SCALE values and test 
again.

X SCALE = 10” ÷ 10 1/32” x 1= 10” ÷ 10.03” x 1 = 0.997

Or, in metric, X SCALE = 250 mm ÷ 250.8 mm x 1 = 0.997

Repeat for Y SCALE. In this example, assume the Y side drew smaller than 10” 
and the calculated Y SCALE is 1.002.

Return to the SCALE screen and enter the values using the + and – buttons:

In your design software, add a square and size it to 
10” x 10” or, if using metric units, 250 mm x 250 mm.

On the Muse Servo control panel, go to 
SET>ADVANCED SETTINGS>SCALE (Fig 2.7.1). 
The following window opens where you can verify 
that the current X and Y SCALE values are both set to 
1.0000:

Fig. 2.7.1

Fig. 2.7.1



2.8 Poll Size & Media Initialization

The MUSE Servo has two features that allow users to know the width of media before cutting. One is 
the Width Test function in the System Information menu. The other is the Poll size function in the LXI 
22 Prodcution Manager and Cut/Plot windows. The Width Test can be done on the cutter once vinyl is 
loaded. 

To use the poll size feature in the LXI Cut-Plot window, create your graphic and click File/Cut-Plot.
    From the Cut-Plot window, click the Poll icon in the upper right area of the preview screen (Fig 2.8.3)
    The Servo cutting head will scan the loaded vinyl and update the Material Width. The Cut-Plot setting
     will change to User Defined and the newly scanned media width will be displayed (Fig 2.8.4).
    The preview will be updated showing the design relative to the updated media width.

Fig. 2.8.2

Load vinyl. 
Then press W Test to initialize 

the media setup.
The cutting head will travel 

across the platen, find the left 
edge of the loaded vinyl, return 

to the home position, and 
display the scanned media 
width as the new Material 

Width 

Fig. 2.8.1

Fig 2.8.2 shows the result of the 
W Test with a 23 inch roll or 
sheet of vinyl on the platen. 

Fig. 2.8.3 Fig. 2.8.4

Click the Poll icon (Printer 
with ?) to initiate the 

poll-size function. 
Notice the Material size is 
set to the driver’s  default 

of 24.060” 

Notice the Preview shows 
the graphic on a 24” wide 
work area based on the 
default Material width

Notice the Material size is 
now ‘User defined” and the 

width has changed to 
14.683” - the width of the 

scanned vinyl. 

Notice the Preview now 
shows the graphic on a 
14” work area based on 
the polled data from the 

cutter.



Print and Cut (Contour Cut)

3.0 Contour Cutting with your Muse Servo

The Muse Servo uses a combination of hardware, firmware, and software to enable easy 
contour cutting of digitally printed images.

Contour cutting is a process where an image is sent to a printer with registration marks added 
around the image. The printout is then placed in the vinyl cutter and the vinyl cutter’s camera 
scans the registration marks. It then knows where to cut the contour path around the printed 
image, based on where the registration marks are located relative to the project in the 
software you’re using.

This chapter covers the calibration of the camera and an overview of the process. For more 
detailed instructions, including video tutorials, go to the SIGNWarehouse Tech Support blog at:
http://techsupport.signwarehouse.com/

3

3.1 Camera Calibration

Your Muse Servo is unlike other cutters. Most contour-cutting vinyl cutters use a laser scanner 
to scan printed registration marks. The Muse Servo has an advanced camera that provides fast 
and consistent scanning and supports very precise calibration.
 
If you find that alignment of the cut path and the intended contour is not ideal, you can bring 
them into alignment by calibrating the camera. Under normal circumstances, the camera 
alignment should only be done once, but if your cutter is jostled or damaged in transit, you may 
need to recalibrate the camera.

What you need for calibrating:

Use the test pen and a function on the control panel to draw a pattern of vertical and 
horizontal lines on a sheet of paper.

1.

2.

A sheet of white copy paper

Muse test pen (see item #9 in Section 1.4)

The camera calibration process is quite simple. Here’s a brief summary. Step-by-step instructions will follow.

NOTE: If you own a Muse Servo 60 model and plan to use both cutting heads, the calibration 
for both can be done at the same time. Refer to Section 4.1.



The camera will then take a photo of this pattern and the display will show the plotted 
image with a small red cross and long dotted blue lines superimposed.

Tap the middle of the pattern with your finger to move the small red cross close to the 
center. You can use the arrow keys, if you like, to place it more precisely in the middle. 
The x3 button on the control panel enables magnifying the camera view for extremely 
precise alignment.

The Muse Servo will take over and locate the center precisely. You will then conclude the 
calibration by pressing STOP on the MAIN SCREEN.

 Step-by-Step Calibration Process3.1.1

The following steps show you how to create your own preset of cut settings:

1.

2.

3.

4.

5.

6.

7.

8.

9.

Load the sheet of paper into the cutter, taking care to adjust the position of the pinch rollers so 
that the paper is securely placed on the platen.

The recommended SPEED and FORCE settings for the camera calibration are 8 and 30, respectively. 
This will help the pen draw a clear and clean test pattern for the calibration.

Place the test pen into the tool carriage. You can open the lid to gain more room to insert the test 
pen. Make sure you position the pen in the blade holder seat so that it’s low enough to mark the 
paper when lowered, but high enough to clear the paper when the blade holder seat is raised. Use 
the TEST button to draw a test square to make sure the pen is positioned correctly.

Once your small test square is cleanly drawn, move the pen over so that the calibration pattern will 
not be drawn on top of your last test.

From the main screen, press SET>CAMERA.

Press START. The test shape, which is a grid 
of 6 lines, will be drawn on the paper and 
the camera will move over the test shape, 
take a photo, and display the photo on the 
control panel.

If you cannot see the test shape clearly, 
press the LED button once so that it reads 
LED 50%. You can also use the X3 button to 
zoom in, if needed. Press the PIC button to 
take another photo. You should see three 
items in the photo: the test shape that was 
drawn with the pen, a red +, and the blue 
dashed +:

Select ADJUST to open the screen for 
calibrating. Press the Start Arrow in the 
lower right corner: 

Press and hold for several seconds 

Fig. 3.1.2

Fig. 3.1.1

Tap your 
finger here

Select
Adjust

Press and hold OK

Press Start



 Adding a Contour Cut to a Design3.2.1

Design or import the image which will be 
printed.

To add a contour path for cutting, select the 
design and go to Effects>Contour Cut. This will 
open the Contour Cut dialog in the Design 
Central toolbox and a contour cut should 
appear:

10.

11.

Tap your finger near the middle of the drawn test shape 
on the screen. This will move the red + close to that 
location.

Press OK. A new photo will be taken and one of two things 
will happen:

12. Once the alignment is in place,  press the HOME button 
and then press STOP on the MAIN SCREEN to save the 
calibration and conclude the process:

This section presents the desktop print-and-cut workflow which requires LXi Master or Master Plus, and a 
desktop inkjet or laser printer. For large-format print-and-cut instructions for LXi RIP, please refer to Section 3.3.

The red + is so close to the center that the Muse Servo’s 
camera will now take over and find the true center on 
its own. You will see the red + and the blue dashed + 
aligned in the center and the arrows (only) will return 
to their blue color. Refer to the left side of the next 
screenshot.

3.2 Contour Cutting with Vinyl Express LXi Master Plus

Fig. 3.2.1

Blue dashed + is also much closer to the middle of the test shape

Red + is now much 
closer to the middle 
of the test shape

The red + and the blue dashed + are still not aligned. 
Refer to the right side of the next screenshot. You will 
need to tap the center again and press OK. Continue, if 
needed, until the center is identified automatically.

Once the red bombsight is aligned over the blue and 
both are aligned over the scanned crop marks, the 
cutter’s camera has been calibrated. (See fig 3.1.3 at 
right).  You are now ready to contour-cut printed 
graphics with precise alignment. 

Red + and Blue dashed are both aligned. Camera is calibrated. 



Adjust the Offset based on how large a border you want to create between the edge of the 
printed image and the cut path.

To place the cut path inside the printed area for a ‘full bleed’ decal, select a negative value in 
the Offset instead (e.g. -0.0125). Once you have the setting you want and the preview looks 
acceptable, press the enter key on your keyboard or click the green check mark icon in the 
Design Central window to apply the settings.

 Adding Registration Marks and Printing3.2.2

1. With the design and its contour 
selected, go to Effects>Contour 
Cut Marks. In this Design 
Central window, the type and 
sizing of registration marks can 
be modified. First, select SAi 
Automatic from the drop-down 
menu and the marks will 
appear like this:

2. By default, the registration mark settings are far more conservative than needed when using the Muse 
Servo’s camera. In order to make them smaller and move them closer to the design, select Options (as 
shown in the prior screenshot). In this next window, you can change to these smaller settings for the Mark 
Length and the Margin:

3. Click on OK to update the registration marks and then click the green check mark icon to apply the 
settings.

Fig. 3.2.3

Fig. 3.2.2



 Contour Cutting to the Muse Servo3.2.3

1.

2.

Load the printout into the Muse Servo using the same orientation as on the screen in LXi. In the example 
being used, FIG. 3.2.5 shows a Landscape orientation and the printout should also appear the same. This is 
then how the printout would also be loaded. Note that if the material is not backed (e.g. paper or cardstock), 
the Muse Servo’s cutting mat should be used as the carrier.

Try to load the material straight so that the front registration marks are parallel to each other on your Muse 
Servo ’s platen. Move the tool carriage so that the blade is over the lower right registration mark. The blade 
needs to be close to the bottom corner as shown in FIG. 3.2.7

3.

4.

5.

4. Go to File>Print and verify that all settings and 
the Preview appear correct. You may need to 
go to File>Document Setup and/or File>Print 
Setup to make changes. Otherwise, the Print 
window should show your project with the 
registration marks. Also, verify that the Scale 
is set to 100% before clicking OK to print:

In LXi, go to File>Cut Contour. LXi Production 
Manager will open, as well as the following Cut 
Contour window, where you can verify the correct 
cutter is selected (in case you have more than one 
set up):

In the LXI CutPlot window, make sure the page size 
matches that set in the design space. Do not resize 
or move the graphic. Leaving it in the default 
setting, in the lower right corner provides the best 
setup for accurate scanning of the registration 
marks. You may need to mount the sheet of media 
on an adhesive cutting mat to provide more space 
around the sheet to place the pinch rollers and 
allow the cutter to scan all the marks. 

Click Send and the Muse Servo24 will start to scan 
the marks and automatically perform contour cut.

Fig. 3.2.8

Position the blade over the lower right corner of 
the lower right registration mark.

Fig. 3.2.7Fig. 3.2.6

Fig. 3.2.5



1.

2.

3.

Import or design the project. To create a contour cut line use 
the same procedure from Section 3.2.1. In this example the 
following design has a negative contour Offset added:

Click on the RIP and Print icon to open the RIP and Print 
window, as well as Production Manager. You’ll observe the 
design aligned in the lower right corner of the preview. Select 
the design and center it on othe page to move it away from 
the corner. Otherwise, when the camera moves to photograph 
the first registration mark, it could send the cutting head out 
of range on the right side of the Muse Servo:

Note the following in the RIP and Print window:

3.3 Contour Cutting with Vinyl Express LXi RIP Design

The RIP Design license allows use of large format printing (with the drivers for the large format 
printers included) as well as color management tools. The following steps present a typical 
workflow:

Fig. 3.2.9

Fig. 3.3.1

Fig. 3.3.4

Center the image to ensure enough margin 
to scan the registration marks 

LXI RIP defaults alignment to Justified right. This often 
leaves no room on the edge of the media to scan the lower 
right registration mark. 

Fig. 3.3.3Fig. 3.3.2

As the camera scans each registration mark, 
the LCD display will show the mark being 
scanned. If, for any reason, the cutter fails to 
scan a particular mark, the camera display 
will show how far off-center the alignment is. 
At that point, you can use the arrow keys to 
adjust the camera to align over the corner of 
the mark, or simply tap the center of the 
screen to prompt the camera to focus on the 
corner of the mark and begin cutting (FIG. 
3.2.9).



4. Click on the Color Management tab and select the appropriate Output Profile:

5. Return to the General tab and select Material size, Job size, and Copies as desired:

6. Click on the Contour tab and confirm all of the following settings before clicking on 
Send:

7. Click on Send and the job will be 
sent to the printer. In the Job 
Production window, the Printer 
queue can be accessed to 
monitor the progress of the 
printing:

Fig. 3.3.6

Fig. 3.3.7

Fig. 3.3.9

Fig. 3.3.5

Rotate and resize the image, make 
copies in the General tab with instant 
previews

In the Send window, choose Send as Separate jobs. This will
send the raster data to the printer and hold the vector data in 
the cutter queue until the printed graphic is ready for contour-cutting. 

Click the Edit button below the Draw option window to 
change the speed and force settings. The default is Cut Fast.
Change this to None in order to utilize the speed and force settings dialed 
on on the MUSE control panel. Otherwise, LXI will overwrite the cutter’s 
presets. This may not result in ideal cut quality. Either method can be used. 

Fig. 3.3.8

Rotate 

Copies 

Row & Column
margins 

Select an appropriate ICC 
profile

Contour Tab 



8.

9.

10.

When removing the printout from the larger 
format printer, be sure to allow several extra 
inches above the printed registration marks 
for clearance of the pinch rollers.

1. The MUSE Servo supports segmented registration marks for accurate contour -cutting of larger batches of 
decals. 
This feature is useful when alignment is drifting over the course of a complex print and cut job. Most of the 
process is the same as that outlined above, but there are a few extra steps and options you can use. 

Start by adding a count cut path to your 
artwork in LXI 22. The segmented marks 
can be applied in the Print & Cut Window

NOTE: Design your decals with a bold outline 
whenever possible. Then, in the Design Central Offset 
window, select a slightly negative value, as seen here. 

This places the contour-cut path slightly inside the 
printed area, providing for an extra margin of error in 
aligning the cut paths.  This is especially helpful when 
producing large batches of decals.

Load the printout into the Muse Servo in 
the same orientation as printed and set the 
blade tip over the lower right registration 
mark as was shown in FIG. 3.2.6 and 3.2.7 in 
Section 3.2.3.

In the Job Production window, select the 
Muse Servo tab and the job status should 
indicate Holding. Select the job and click on 
Send at the top:

3.4 Contour Cutting with Segmented Registration Marks

 Using Segmented Registration Marks to Contour-cut long jobs3.4.1

Fig. 3.3.10

Fig. 3.4.1

Fig. 3.4.2

Send to Muse Servo

Set a negative offset or ‘choke’ in the 
Design Central Offset window

2. Set your copies you need in the Print & Cut 
Window. The Preview will show one set of 
registration marks around the set.

Fig. 3.4.2

Remember to center your graphic to 
allow for adequate margins on either 

side of the registration marks. 
This enables the cutter to scan marks 

on both sides of the media.



3. In the Registration Marks window. scroll down to 
change the setting from SA Automatic to SA 
Segmentation.

4. The preview pane will update with segmented 
marks alongside your copies. The placement of the 
marks is determined by the size of the Steps. This 
can be precisely managed in the Registration 
Marks Options window. 

Fig. 3.4.3

Fig. 3.4.4

Fig. 3.4.5

Change the Registration Mark setting to SA Segmentation

Click the Options button to view the settings and 
change the Step size to move the intermediate 
marks. The MUSE Servo will scan and cut the copies 
in groups determined by the step size.  For best 
results, try to align groups of decals by row 
between the intermediate registration marks. This 
ensures that tne entire path is cut in one pass. 

5.

Fig. 3.4.5a

Note the position of the intermediate marks relative to 
the rows between copies.

Adjust the Step Size to place the marks in the margins between copies if possible. 



6. Using the General tab to adjust the margins 
between rows is not recommended. Even if 
the intermediate registration marks are not 
perfectly aligined in the margins, the decals 
will be cut correctly. 

7. Click Send to print the job. The multiple 
copies of the cut job will be sent to the 
MUSE Servo queue in Production 
Manager. The number of copies in the 
general information pane confirms that 
the segmented cut job will be processed 
once the print is loaded. Set the origin on 
the cutter just inside the lower right-hand 
corner of the first registration mark 
before sending the cut job.

Fig. 3.4.7

Fig. 3.4.6

Do Not Adjust the margins between rows. Changing this 
from the default value will cause the alignment to ‘drift’ as 

successive rows are cut.

Fig. 3.4.7

Set the origin on the cutter just inside the lower right-hand corner of the first registration mark before sending 
the cut job.
The Servo will scan the first four marks and cut the first batch of copies, then scan the second set of marks and 
cut the next batch, and so on (See Fig 3.4.8 below).

8.

12 copies of this vector cut job are pending in the MUSE Servo cutter queue.

The lower right mark is 
scanned first, just as with 

standard registration marks.

The intermediate marks in ithe 
corners of the segments are 

scanned in sequence. The copies 
within each segment are cut after 

those marks are scanned.



Import or design your project in Create Space.

To add a contour cut, select the design and go to Effects>Shadow Layer (Contour Cut). In the 
window which opens, you will set the shape and size of your contour cut. Mark the box for 
Print+Cut Outline. Click OK.

NOTE: The Print & Cut Outline option 
automatically sets the Cut Line Type for the 
design to Print+Cut Print. This means it will 
only print and will not cut. It also 
automatically sets the Cut Line Type for the 
contour to Print+Cut Cut which means it 
will not print and will only cut. Note that 
these assignments can be verified or 
changed by selecting a layer and going to 
the Style Panel:

3.4 Contour Cutting with Create Space

 Adding a Contour Cut to a Design and Printing

Fig. 3.4.1

Fig. 3.4.2



If you wish to see the print border for the 
currently-selected printer and the registration 
marks, enable Show Print Margins and Show 
Registration Marks, respectively on the 
Document Panel:

By default, the registration mark settings are 
far more conservative than needed when using 
the Muse Servo’s camera. In order to make 
them smaller and move them closer to the 
design (or to the borders of the printout), go to 
Cutter>Cutter Settings. In the upper right 
corner of this window, you can make changes, 
as appropriate for your needs. For example:

Click the Cutter icon at the top to open the Cut Settings window. Click the Print+Cut button.

The Print and Cut window will open. Adjust the cut settings, as needed.

Click Print to open the Print window. By default, the Print Registration Marks should be 
marked. Click OK to print the project.

Load the printout into the Muse Servo based on the arrow direction (triangle) shown in the 
main window of Create Space. In the example being used, FIG. 3.4.3 shows a Portrait 
orientation (also indicated on the Document Panel) and the printout should be loaded the 
same way. Note that if the material is not backed (e.g. paper or cardstock), the Muse cutting 
mat should be used as the carrier.

 Contour Cutting from Create Space to the Muse Servo3.4.2

Fig. 3.4.3

Fig. 3.4.4

Fig. 3.4.5



Try to load the material straight so that the front registration marks are parallel to each other 
on your Muse Servo’s platen. Move the tool carriage so that the blade is over the lower right 
registration mark. The blade needs to be close to the bottom corner as shown in FIG. 3.4.6.

Select Next to move to the reading of 
the registration marks. You can use the 
arrows on the box to move the 
carriage or use the arrows on the 
cutter to move the tool carriage into 
the right spot. You want the blade in 
the bottom corner of the lower right 
registration mark.

Once in the correct spot, click Start 
Scan and your Muse Servo will begin 
scanning the marks:

Position the blade over the lower right 
corner of the lower right registration 
mark.

As the camera scans each registration mark, the LCD display will show the mark being scanned. If, for any 
reason, the cutter fails to scan a particular mark, the camera display will show how far off-center the 
alignment is. At that point, you can use the arrow keys to adjust the camera to align over the corner of the 
mark and complete the scan, or simply tap the center of the screen to prompt the camera to focus on the 
corner of the mark and begin cutting  (FIG. 3.4.9).

Fig. 3.4.7

Fig. 3.4.8

Fig. 3.4.9

NOTE: If your MUSE Servo fails to 
find the second registration mark, 
you may need to rotate the 
graphic on the platen or cutting 
mat by 90°.

This may be necessary even if 
your CreateSpace mat is oriented 
in portrait mode.  



NOTE: Cutting “on the pull”.  Because window tint film is so thin, it can sometimes wrinkle during plotting. 
To avoid this, some cutter drivers have an option that limits cutting so that the blade is only actuated when 
film is being fed backward into the cutter, as opposed to being fed forward. This is known as cutting ‘on the 
pull’. This setting is found in the LXI Cut-Plot window as (name here). Checking this box activates this 
feature and greatly simplifies the task of cutting thin, sensitive films such a 1-mil metalized polyester, and 
various window tint film. 

4.1 Cutting Window Tint Film 

Normal Window Tint Film using a Muse Servo 30-degree blade and the Muse Blade Holder

The Force should be low; ideal would be between 16-18 on the sliding scale. The blade should 
be adjusted only as deep as the film to be cut. Aim for the lower number when using a new and 
serviceable blade and make adjustments as the blade dulls.

For the Speed, on the sliding scale, 2-4 is ideal. Aim for the lower speed as recommended by the 
manufacturer.

NOTE: For most automotive film applications, the MUSE Servo60 is preferred. The Servo24 has comparable 
speed and force, but  the 60-inch is a better fit for the 42 - 60-inch film widths used in window tint and PPF * 
applications. 
All suggested settings are a starting point. Depending on the brand and type of film, adjustments may be 
required to optimize cut quality. When troubleshooting cut quality issues, always start wtih a fresh blade.

4.3 Window Tint with Muse Servo M60
Automotive Applications
4

Click the Advanced Tab from the 
LXI22 Cut-Plot Window and check the 
Unidirectional Cutting box to activate 

cutting ‘on the pull’ 

Fig. 4.1.1



4.2 Paint Protection Film with Muse Servo M60

Normal Paint Protection Film using a Muse Servo 60-degree blade and the Muse Blade Holder

Paint Protection Film is a PVC film with a thickness of 6 - 12 mil, depending on the brand.

This material is meant for medium-term paint protection of automotive surfaces. Because of the 
thickness of this film, a 60-degree blade is recommended.

The blade exposure should be adjusted so that it will only cut as deep as the film. Please use the box 
test presented in Section 2.1.

The Recommended Force setting is 35-40 on the sliding scale. Aim for the lower number when using a 
new and serviceable blade and make adjustments as the blade dulls. The pressure may vary depending 
on the blade holder as well.

The Recommended Speed setting is 3 (5.9ips) to 5 (9.8ips) on the sliding scale. Slower speeds are 
generally recommended when cutting thick and/or dense films like PPF and prismatci reflective film. ,

Overcut: Due to the thickness of the face film, cuts may not be complete at corners in normal drag knife 
or drag & swivel cutting. To ensure the film is cut all the way through at corners, change the Overcut 
setting to extend cut paths beyond the point of intersection. 

The Recommended Overcut setting is  .3-in to .5-in (0.75-cm to 1.25-cm). Test these settings on your 
film and adjust based on test cut and weeding peformance. 

NOTE: All suggested settings are a starting point, depending on the media adjustments that may be 
required based on the media itself.

Click the Advanced Tab to find the Overcut setting. 
Change this from the defaul 0.100in to 0.500 in. 

This will ensure corners are cut completely .

Fig. 4.2.1



Troubleshooting FAQ

Question:   What's the smallest character I can cut?

 As the name implies, Muse Servo cutters use true digital servo drive motors, rather 
than stepper or micro-stepping motors. The servo drive motors support accurate 
cutting of characters as small as 0.25” (1/4”).  A 60° blade may be required for 
accurately cutting small text to prevent edge lifting during cutting. When cutting 
graphics this small, the speed setting on your cutter should be reduced.

5

Having trouble? Check out these common questions & answers!

Answer: 

Question:   Why is the cut quality inconsistent?      

Inconsistent cut quality is often a function of the speed setting. You can adjust the 
speed across a wide range up to 24 inches per second. High speed is appropriate for 
large simple shapes and letters. But for small fonts and complex shapes, a slower 
cutting speed will produce better quality.

Answer: 

Question:   Why are there rough edges on cut graphics?

1. The knife blade may be protruding too far from the blade holder. Refer to Section 
2.01 and 
   adjust the blade so that you're not cutting too deeply into or through the release 
liner.

Answer: 

Question:   Why doesn't the vinyl track correctly on long cut jobs?

Poor tracking is typically caused by the vinyl being incorrectly loaded into your 
cutter. Whenever possible, position the pinch rollers as close as possible to the 
edges of the vinyl. Allow some margin for error so that the vinyl doesn't 'walk' out 
from under one of the pinch rollers as the roll is fed through the cutter. 

After loading the vinyl and setting the pinch rollers, use the arrow keys to feed the 
vinyl forward and backward a few feet to ensure the media is loaded properly and 
tracking straight. Feeding it forward and back will also place small grooves in the 
face film that aid in consistent tracking. If the vinyl alignment skews consistently to 
one side during cutting or media feed, there may be uneven pressure from the pinch 
rollers. Check to make sure both, or all pinch roller wheels are in the down position. 
If all wheels are down and the vinyl still consistently skews to one side, you may 
need to replace one of the pinch rollers.

Answer: 



Question:   My LCD display doesn’t seem to turn on - or I see a black row of blocks in my LCD 
screen

1. If the LCD is blank, check to make sure your cutter is plugged into a working outlet 
and 
   turned on. 

2. If you’re seeing black blocks on the LCD screen, make sure you're getting adequate 
    voltage to your cutter (your outlet may be lower voltage). If you’re plugged into a 

Answer: 

Question:   Why are some of the letters cut incompletely?

1. Make sure the blade holder is correctly installed in the tool carriage.

2. Check the blade tip to make sure it isn’t damaged.

3. The blade holder may be worn out. As blade holders age, their control of the 
blade’s 
    movement is degraded. The first sign of this is often incompletely cut shapes, such 
as 
    rectangles with uncut corners.

4. Reinstall the software and check with your IT support staff to ensure there is no 
    interference between your computer and your cutter. Anti-virus software can 
sometimes 
    cause interference in the communication to your vinyl cutter, for instance.

Answer: 

Question:   Why does my cutter cut more deeply in one part of the vinyl than another?

There is a Teflon strip that covers the width of your cutter under the path of the 
cutting head along the X axis (left to right). When your vinyl cutter is properly set up 
and cutting vinyl at the proper depth, the blade doesn't touch this strip. If the blade 
is incorrectly installed, or if your cutter is allowed to cut beyond the vinyl, the Teflon 
strip may become scratched. If this happens frequently, the strip will become 
damaged causing that area of the strip to push upward against the bottom of the 
vinyl resulting in inconsistent depth across the platen. Contact SIGNWarehouse and 
purchase a replacement for the Teflon strip.

Answer: 

Question:   Why isn't my Muse Servo responding to jobs sent from the software?

1. This is almost always caused by selecting the wrong port in the setup process. 
Refer to 
   Section 1.10 and make sure your cutter is in the correct mode for plotting by USB 
or Wi-Fi. If 
   you're using the USB port, make sure the Port Setting in the LXi Production 
Manager is 
   USB_Printer_0.

2. If the settings are correct, but your cutter isn't responding, open the LXi 
Production 
    Manager, change the USB port or connection method, and send a test cut. Repeat 
until you 
    find the correct USB port for the computer. For more detailed instructions, please 

Answer: 



Question:   Why can't I weed the graphics after cutting?

Most likely, you haven't cut the vinyl deeply enough to cut through the face film and 
adhesive. To fix this, adjust the pressure setting and perform a test cut. This can be 
done from the control panel or from the LXi Production Manager. Weed the test 
pattern to make sure the vinyl's face film and adhesive have been cut, but that the 
release liner isn't scored too deeply. Adjust the pressure setting as needed. Then 
proceed with your vinyl graphics.

Answer: 

Question:   What kind of maintenance does my Muse Servo cutter need?

All Muse Servo plotters are made with high-quality internal lubrication to protect all 
mechanical components. Therefore, there is no need to oil or lubricate any of the 
components, ever! Daily care consists of cleaning the platen and blade holder to 
prevent buildup of dust and vinyl debris. Dusting the platen with a soft brush will get 
the job done perfectly. Vinyl debris in the blade holder can be removed using a can 
of compressed air and a nozzle.

Answer: 

3. Check the settings in your LXi Production Manager and make sure the send mode 
window 
    is set to Send Now (Fig 5.8). If the setting is File or Hold in List, the data won’t be 
sent from 
    your computer to the vinyl cutter. If it is set to Hold in List, you will find the jobs 
holding in 
    the cutter queue. Click on the job in the queue and use the File/Cut Plot command 
or click 
    the Send icon.

Fig. 5.8
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Appendix I: Specifications

Drive System
Max Media Width
Max Cutting Width

Max Cutting Force
Max Moving Speed
Max Cutting Speed
Cutting Precision

Repeat Precision
Contour Cutting
Mark Sensing Method
Processor Memory
Interface Options

Power Supply
Power 
Product Dimensions

Package Dimensions

Shipping Weight
Working Environment

Supported Software
Floor Stand

Canvas Media Basket
Media Handling System

MUSE Servo24 MUSE Servo60
Digital Servo 

28.4” (720mm) 64.9” (1650mm) 
24” (610mm) 60.6” (1540mm) 

8000g 
47 ips (1200mm/s) 

47 ips (1200mm/s) 
plus/ minus-0.01mm 

0.082mm 
Yes 

Camera 

128MB 
USB Cable | USB Disk | Wifi 

110/50 

<100W
37.5" x 11" x 10" 
955 x 280 x 255mm 

74.2" x 11" x 10" 
1885 x 280 x 255mm 

42" x 15" x 16" 
1066 x 381 x 406mm 

76" x 15" x 16" 
1940 x 381 x 406mm 

44lbs (20kg) 104lbs (47kg)
41°-95°F (+5° - +35°C)

LXI 22 | Create Space v6 | SignLab 11 | Flexi Complete

Optional
Optional
Optional

Optional
Optional

Included

Product Specifacations based on manufacturer data. Subject to change without notice.
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Appendix II: Cutting Guide
Optimal performance with any vinyl cutter depends on using the best settings for the material used. As noted in segment
2.3, the MUSE Servo supports storing custom presets for quick changes from one material to another. If you are unsure 
what speed and force settings to use for a particular vinyl or film, consult this guide. 
NOTE: All suggested settings are a starting point. Depending on the media and the condition of your blade, you may find 
some fine adjustments may be required for optimal cutting and weeding performance. For best results, always start with  a 
fresh blade and begin by dialing in the proper blade exposure using the manual box test discussed in segment 2.1

Blade Force SpeedMaterial
Calendared Vinyls
ORACAL 631

ORACAL 651
ORACAL 641

EnduraGLOSS

Holographic Vinyls
Schein Mosaic

Schein Carbon Fiber
Schein Chrome Polish

Reflective Films
EnduraLITE 48000
EnduraLITE 8100
ORALITE 5300
ORALITE 5600
ORALITE 5700
ORALITE 5800

Cast Vinyls

Paint Mask Stencil

ORACAL 751
ORACAL 851 GlitterCAST
ORACAL 951

ORAMASK 813
ORAMASK 810S

45° Blade

45° Blade
45° Blade
45° Blade
45° Blade

45° Blade
45° Blade

10
10
10
12

18
20
24
24

24
24
26

10
10
10

60° Blade

10

10
10

38
4245° Blade

45° Blade 1038
60° Blade 38 10
45° Blade 40 10
60° Blade 70 2

24
36
24

45° Blade
45° Blade
45° Blade

10
10

60° Blade
60° Blade

26
20

10
10



Appendix II: Cutting Guide

Blade Force SpeedMaterial
Heat Transfer Film (HTV)
SISER Easy Weed
Chemica Hotmark
Logical Color WarmPEEL Universal

Sandblast Resist Stencil
Hartco 425
Hartco 535
Hartco 935 Equalizer

Paint Protection & Window Tint Film
ORAGUARD 270 StoneGuard
ORAGUARD 2815 PPF
High Performance Window Tint Film

102845° Blade
103045° Blade
102845° Blade

109060° Blade
60° Blade 95 4

60° Blade
60° Blade
30° Blade

35 - 40

16 - 18

3 - 5

2 - 4
35 - 40 3 - 5

* Please refer to segment 4 for more important tips for optimizing cutting and weeding quality 
with window tint and paint protection films.   

*


